
Abort a Partition Operation
Purpose
Use this feature if you want to back out of an operation, or, if your NDS* network returns NDS errors or fails to 
synchronize following a partition operation.
You can abort a partition operation from either the Tree view or the list of Partitions and Servers.

Abort a Partition Operation
1.  Choose the partition where an operation has begun.

Hint: If you are attempting to abort a merge partition operation, choose the partition (the child partition) that is 
merging with its parent. If you are attempting to abort a create partition operation, choose the parent partition.

2. Right click the partition.
3. Choose Abort Operation.
4. Confirm your request.
For more information, see Overview of Aborting a Partition Operation.
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Add a Replica
Purpose
Creating multiple NDS* partitions does not, by itself, increase fault tolerance or improve performance of the Directory.
However, strategically using multiple replicas does.
Add a replica of a partition to a server to provide your Directory tree with

Fault tolerance
Faster access to NDS data
Faster access across a WAN link
Access to NDS objects in a set context (using bindery services)

You can add a replica of a partition to a server from either the Tree view or the list of Partitions and Servers.

Add a Replica
1. Choose the partition that you want to replicate on a server.

2. Choose Add replica .

3. Click the browse button  to choose the server to place the replica on.
4. Choose the NetWare* Server object from the browser and choose OK.
5. Choose either Read/Write or Read Only.
6. Choose OK.
7. Confirm your request.
For more information, see Overview of Adding a Replica.
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Assign a New Master Replica
Purpose
Important: Don't use this feature to change a replica type. This is a repair feature that should only be used under the 
following conditions:

The current master replica is corrupted
The server the current master resides on lost data integrity
The server the current master resides on has had an unrecoverable hard disk failure

You need a master replica to perform operations with a partition. Assigning a new master replica allows you to 
convert an existing replica to the master replica, and therefore allows you to perform partitioning operations.
Before assigning a new master replica, you should try to change an existing replica to master using the Change 
Replica Type operation from the Tree view or from the list of Partitions and Servers.

Assign a New Master Replica
1. From either the Tree view or the list of Partitions and Servers, choose the partition whose master is corrupted or

unrecoverable.

2. Choose Partition Continuity .
3. From the Partition Continuity view, choose the server (the row) that you want the partition's master replica 
to reside on.

4. Choose    Assign New Master .
5. Confirm your request.



Change Replica Type
Purpose
Change a replica type to control access to the replica information. For example, you might want to change an existing
read/write replica to a read-only replica to prevent users from writing to the replica and modifying Directory data.
Note: You can't use this procedure to change the type of the master replica. To specify a new master replica, change 
the type of an existing read/write or read-only replica to master, and the original master replica is automatically 
changed to read/write.
You can change a replica type from either the Tree view or the list of Partitions and Servers.

Change a Replica Type
1. Choose a partition or a server.
2. From the replica pane, choose the replica you want to change.

3. Choose Change replica type .
4. Choose a new type and choose OK.
5. Confirm your request.
For more information, see Overview of Changing Replica Type.



Check Partition Continuity
Purpose
This operation helps you identify whether any of a partition's replicas are experiencing synchronization errors. This 
operation is also known as "walking the replica ring."
You can check partition continuity from either the Tree view or the list of Partitions and Servers.

Check Partition Continuity
1. Choose the partition whose synchronization status you want to view.

2. Choose Partition Continuity .
In the Partition Continuity view, a replica icon with an exclamation point indicates a replica with synchronization 
errors. To get context-sensitive help on an error, double-click the replica icon.

For more information, see Overview of Checking Partition Continuity.



Check Synchronization Status of a Partition
Purpose
NDS* Manager will read the partition status attribute for the partition to determine any synchronization errors. This is 
a low-level diagnostic check that is safe to perform under all circumstances.
You can check the synchronization status of a partition from either the Tree view or the list of Partitions and 
Servers.

Check the Synchronization Status of a Partition
1.  Choose the partition you want to check.

2. Choose Check synchronization .
3. (Optional) If you attempted this operation from the list of Partitions and Servers, you can choose to view 
the synchronization status of all the partitions in your Directory tree.
4. Choose OK.
5. Confirm your request.
For more information, see "Overview of Checking the Synchronization Status of a Partition" in the help topic Overview
of Viewing Partition Data.
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Compatibility Issues
NDS Manager Compatibility

We recommend upgrading all NetWare v4.10 servers to the latest NDS available on NetWire for NetWare 
v4.10. Note: NDS in Green River is incompatible with NDS versions for NetWare 4.10 prior to v4.89a.

We recommend using NetWare Client 32 when running NDS Manager.
NDS Version Compatibility

NDS Manager fully supports NDS v4.89a and above as well as DSREPAIR.NLM v4.31 and above.
NDS Manager does not support DSREPAIR.NLM versions prior to 4.31.
NDS Manager provides limited support for NDS versions prior to v4.89a running on NetWare v4.10 servers. 

NDS v4.89a provides the ‘partition status’ attribute which stores synchronization errors that occur when a replica 
synchronizes with other servers in the replica list. This attribute allows NDS Manager to provide synchronization 
information about partitions. Issues for pre- v4.89a NDS include the following:

If Check Synchronization is performed on a partition that has all of its replicas stored on v4.10 servers 
running NDS versions prior to v4.89a, a synchronization error will be displayed even if one does not exist.

If Check Synchronization is performed on a partition which has some replicas stored on v4.10 servers 
running NDS versions prior to v4.89a and some replicas stored on v4.10 servers running NDS versions 4.89a or later,
the following will occur: If NDS Manager reads the partition information from one of the servers running NDS prior to 
v4.89a, a synchronization error will be displayed even if one does not exist. If NDS Manager reads the partition 
information from one of the servers running NDS v4.89a or later, a synchronization error will be displayed only if one 
exists.

Partition and Replica Information will not display information for some fields if the information for the partition
or replica is read from a server running NDS version prior to 4.89a.

The Partition Continuity Grid will not show any synchronization errors (even if they exist) for replicas stored 
on servers running NDS versions prior to 4.89a.
Windows 95 Compatibility
When running NDS Manager on Windows 95, be aware of the following:

NDS Manager uses many context handles (each process in Windows 95 is limited to 16 context handles)
If you begin to receive error -328 while running NDS Manager on Windows 95, close some of your open 

windows in NDS Manager and retry the operation.
Client Software Compatibility
If you are running NDS Manager on VLMs, be aware of the following (upgrading to Client 32 will avoid all of the 
following):

VLMs default to a maximum of eight simultaneous connections to servers. This can cause "Unable to attach"
and "Unable to read" errors (often in the form of statuses -321, x8801, and x8809) in NDS Manager.

You may also get notices that servers are down when they are not (NDS Manger simply cannot connect to them 
because it is out of available connections). You can increase the maximum number of simultaneous connections 
when running VLMs by adding a "CONNECTIONS=n" entry to your NetWare DOS Requester section of your 
NET.CFG. VLMs support from two to 50 connections. Ideally, for NDS Manager, your workstation should be 
configured to support a number of connections equal to the number of servers in your tree. Refer to Dynatext for 
compatibility notes on this configuration option if you are running NetWare v3.x servers on your network.

If you are running VLMs and network traffic is heavy and NDS Manager tries to connect to a server which is 
down, it may take a very long time to return an "Unable to attach" error.

Since NDS Manager must connect to each server in the replica list of a partition to display the Partition 
Continuity grid, you may see a lot of "Unable to read" errors when running VLMs which are configured for fewer 
connections than servers in the tree.

If your workstation is configured in this way, the connections will often be reused to read different servers when 
the grid is created. Subsequent actions on rows which display data may result in "Unable to attach" errors. 
Update synchronization information will update these rows to "Unable to read" status.
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Create a Partition
Purpose
When you create partitions, you make logical divisions of your NDS* tree. These divisions can be replicated and 
distributed among different NetWare 4* servers in your network.
When you create a new partition, you split the parent partition and end up with two partitions. The new partition 
becomes a child partition. For recommendations, see Guidelines for Partitioning and Replicating Your Tree.
You can create a partition only from the Tree view.

Create a Partition

1. Choose Tree view .
2. From the browser, choose the container you want to create as a partition.

3. Choose Create Partition .
4. Confirm your request.
For more information, see Overview of Creating a Partition.
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Delete a NetWare Server Object
Purpose
Warning: Deleting a NetWare* Server object permanently removes the object from your network. It also 
permanently removes the server's data and resources from the network.
Deleting a NetWare Server object may corrupt your NDS* database, especially if the NetWare Server object provides 
NDS database services (such as storing replicas).
Use NDS Manager to remove the replicas from the server and avoid deleting a server that stores the only replica of a 
partition of the Directory tree.
You can delete a server from either the Tree view or the list of Partitions and Servers.

Delete a NetWare Server Object
1. Choose the NetWare Server object you want to delete.

Note: If you are in the Tree view, you must browse the tree by expanding containers until you locate the NetWare
Server object in the correct context. If you know the context where the server resides, you can set the context 
from the View menu.

2. Right-click and choose Delete.
For more information, see Overview of Deleting a NetWare Server Object.
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Delete a Replica
Purpose
Deleting a replica removes the replica of a partition from a server.
You can delete a replica from either the Tree view or the list of Partitions and Servers.

Delete a Replica
1. Choose the partition that has a replica you want to delete.
2. From the replica pane on the right, choose the replica you want to delete.
3. Right-click and choose Delete.
4. Confirm your request.
For more information, see Overview of Deleting a Replica.



Description of Replica States
Replicas can be in many states, depending on the operations that are executing in the background.
Click a state for an explanation.

On
New
Dying
Locked
Change Type 0
Change Type 1
Transition On
Transition Move
Transition Split
Split 0
Split 1
Join 0
Join 1
Join 2
Move 0
Move 1
Move 2



Descriptions of Replica Types
NDS* uses four types of replicas.

Master replica
A master replica is a writable replica that contains all object information for the partition. All partition operations 
(create, merge, move, delete) occur from the master replica of the given partition.
Only one master replica can be defined for each partition.

Read/write replica
A read/write replica contains the same object information as the master replica. It allows modifications (writes) when a
master replica of the given partition is already defined somewhere else.
There can be any number of read/write replicas.
Client workstations can update master and read/write replicas only.

Read-only replica
A read-only replica contains the same object information as the partition, but the information can only be read. It is 
used where partition reads are required, but writes to the partition should not occur.
A read-only replica cannot be used on a server where bindery services is required because bindery services requires 
a writable replica. When bindery services are required on a server, use either a master or read/write replica. The 
NetWare 4 install will (by default) ensure that if fewer than three replicas of the root of the current tree exist in the 
tree, a Read/write replica of that root will be added to the server being installed.

Subordinate reference replica
A subordinate reference replica cannot be modified by any user. It is automatically placed on a server by NDS if the 
parent partition has a master, read/write, or read-only replica on the server and no replica of the child partition exists 
on the server.
If you add a read/write or read-only replica of the child partition to the server, the subordinate reference replica is 
removed.
Network resources are held in the master, read/write and read-only replicas. Read-only replicas have limited scope 
and are not typically implemented. Subordinate reference replicas are automatically allocated and created, and tie the
partitions of the tree together.
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Guidelines for Partitioning and Replicating Your Tree
The following guidelines are only rules of thumb for most networks. However, depending on your network's specific 
configuration, hardware, and traffic throughput, you may need to adjust some guidelines to fit your needs. For 
additional information on designing your NDS* tree, managing partitions and replicas, and managing time 
synchronization, see Guide to NetWare 4 Networks.

Guidelines for Partitioning
Location

In a network with WAN links, partitions should not span multiple locations
Partition locally around the servers (keep physically distant servers in separate partitions)
Place fewer partitions at the top of the tree with more at the bottom

Size
Keep partition sizes small
The root of the current tree partition should remain small
Typically, a partition should have fewer than 1,500 objects, and no more than 3,500
Typically, a partition should have fewer than 10-15 subordinate partitions, and no more than 40

Example
The following graphic shows a typical tree structure. Note how the Sales Organizational Unit is a partition. This could 
be because the Sales OU is across a WAN link, or because it has a large number of User objects in it.

Guidelines for Replication
Placement

 Replicate locally, not across a WAN link (Replicas across a WAN link have to send/receive NDS 
synchonization information, which can slow down network traffic across a WAN link)

If possible, place master replicas physically close to the master of parent and child partitions
Number

Always keep 2 or 3 replicas per partition, and no more than 10
Never store more than 10 replicas on a server
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Abort Partition Operation
Purpose
You can abort a create or merge partition operation if the operation has not yet progressed past the stage at which 
the change is committed. Use this feature if you want to back out of an operation, or if your NDS* network returns 
NDS errors or fails to synchronize following a partition operation.
For more information, see Overview of Aborting a Partition Operation.

Options
In the text box, the complete name of the partition you chose is shown. If you are attempting to abort a merge 
partition operation, choose the partition (the child partition) that is merging with its parent. If you are attempting to 
abort a create partition operation, choose the parent partition.
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Add Replica
Purpose
Creating multiple partitions does not, by itself, increase fault tolerance or improve performance of the Directory. 
However, strategically using multiple replicas does.
Novell* recommends three replicas for each partition (if the Directory tree has enough servers to support that 
number). For other recommendations, see Guidelines for Partitioning and Replicating Your Tree.
Add a replica of a partition to a server to provide

Directory fault tolerance
Increased access performance across a WAN link
Faster access to Directory information
Access to bindery services

For more information, see Overview of Adding a Replica.

Options

For explanations of features, click where appears.
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Assign New Master Replica
Important: Don't use this feature to change a replica type. This is a repair feature that should only be used under the 
following conditions:

The current master replica is corrupted
The server the current master resides on lost data integrity
The server's hard disk crashed and is unrecoverable

You need a master replica to perform operations with a partition. Assigning a new master replica allows you to 
convert an existing replica to the master replica, and therefore allows you to perform partitioning operations.
Before assigning a new master replica, you should try to change an existing replica to master using the Change 
Replica Type operation from the Tree view or from the list of Partitions and Servers.



Change Replica Type
Purpose
Change the type of a replica to control access to the Directory data on that replica.
For example, you might want to change an existing read/write replica to a read-only replica to prevent users from 
writing to the replica and modifying Directory data.
For more information, see Overview of Changing Replica Type.

Options

For explanations of features, click where appears.



Check Synchronization
This operation allows you to check the synchronization status of a partition---or of all the partitions---in your tree. This 
is a low-level diagnostic check that is safe to perform under all circumstances.
NDS* Manager will read the partition status attribute for each partition to determine any synchronization errors. NDS 
Manager will display the findings of the synchronization check in a dialog box. You can then check the partition 
continuity of any partitions that have returned errors and then run repair operations on those partitions.
Note: The option All Partitions contained in the partition list is not available unless you have chosen this 
operation from the list of Partitions and Servers.
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Create Partition
When you create partitions, you make logical divisions of your NDS* tree. These divisions are called subtrees, and 
they can be replicated and distributed among different NetWare* 4* servers in your network.
When you create a new partition, you split the parent partition and end up with two partitions. The new partition 
becomes a child partition.

For example, if you choose an Organizational Unit and choose to create it as a new partition, you split the 
Organizational Unit and all of its subordinate objects from its parent partition.
For more information, see Overview of Creating a Partition.
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Delete Replica
Deleting a replica removes the replica of the partition from a server.
If you want to remove a server from the Directory tree, you can delete replicas from the server before removing it. 
Removing the replicas reduces the chance of having problems removing the server.
You can also reduce synchronization traffic on the network by removing replicas. Keep in mind that you probably 
don't want more than six replicas of any partition.
Note: You cannot delete a master replica or a subordinate reference.
When you delete replicas, keep the following guidelines in mind:

For fault tolerance, you should maintain at least three replicas of each partition on different servers.
Deleting a replica deletes a copy of part of the Directory database on the targeted server.

The database can still be accessed on other servers in the network, and the server that the replica was on still 
functions in NDS*.
You cannot delete or manage subordinate reference replicas. They are created automatically on a server by NDS 
when the server contains a replica of a partition but not of that partition's child.

For more information, see Overview of Deleting a Replica.
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Delete Server
Warning: Deleting a NetWare* Server object permanently removes the object from your NDS* tree (the server still 
has SAP capabilities unless it is permanently down).
It also permanently removes the server's data and resources from the network.
Deleting a NetWare Server object may corrupt your NDS database, especially if the NetWare Server object provides 
NDS database services (such as storing replicas).
Use NDS Manager to remove the replicas on the NetWare server and avoid deleting a NetWare server that stores the
only replica of a partition of the Directory tree.
You want to delete a server when:

The server's hard drive goes bad and you want to reinstall the server.
You no longer need that resource in the tree due to company downsizing.

There are several ways to go about deleting a NetWare Server object:
One option (although we don't recommend this) is to bring a NetWare server down and delete its object.Then, 
reinstall NDS on the server using INSTALL.NLM at the server, or recreate the object after bringing the server back 
up.You will have to use NetWare Administrator to delete Volume objects associated with the deleted NetWare Server 
object.
Do not delete a server if you merely wish to move it to a new context. Use the NetWare Administrator to move the 
server object and its associated volume objects to another context.
If the server is functioning properly, do the following before deleting it:

Change the master replicas stored on this server to read/write replicas and then delete all replicas on the 
NetWare server.

Remove NDS from the server with the INSTALL.NLM. This procedure protects your NDS database from 
losing services. (This procedure will also delete the server for you.)
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Error Information
Purpose
From this dialog box you can view the synchronization error information on a replica of the chosen partition.
From Partition Continuity, you can identify replicas in the grid which have synchronization errors.

Options

For explanations of features, click where appears.



List of Partitions and Servers
Purpose
The list of Partitions and Servers is one of the three views from which you can work in NDS* Manager (the other 
two are the Tree view and Partition Continuity).
This view displays all partitions and servers in and below your current context. If you want to see which partitions are 
parent and which are child partitions (the partition hierarchy), you must go to the Tree view.

To perform repair operations, you must choose a partition and then choose Partition Continuity .

Options

For explanations of features, click where appears.
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Log File Error
Purpose
The Logfile Error dialog box appears if NDS* Manager fails when it attempts to write to the log file after performing 
an NDS version update operation.
Some possible reasons NDS Manager can't write to the log file are

The specified directory does not exist
If the file is not in the directory, NDS Version Update will create it.
The location of the log file is specified in your Preferences. To view your Preferences settings, from the Object 
menu, choose Preferences.

The file is set to read-only
The file is damaged

Options

For explanations of features, click where appears.
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Merge Partition
Purpose
When you merge a partition, the chosen partition and its replicas combine with the parent partition. When the 
operation is complete, only one partition (the parent partition) exists.
For more information, see Overview of Merging a Partition.

Options
Partition
Displays the complete name of the partition to be merged. To change the partition to be merged, choose No and 
choose a different partition.
Parent Partition
Displays the complete name of the partition's parent. You can't change the information in this field. It will always 
display the parent partition of the partition you have selected.



Move Partition
Purpose
Moving a partition lets you move a subtree in your Directory tree. You can move a partition root object (which is a 
container object) only if it has no subordinate partitions.
For more information, see Overview of Moving a Partition.

Options

For explanations of features, click where appears.



Move Partition
Purpose
This screen will display when you are trying to move a partition to a context where an alias already exists.



NDS Update Error
Purpose
NDS* Manager is unable to complete an NDS version update operation because of one or more problems on the 
specified server. Some possible explanations are

The server is down or busy
The server is corrupted
You don't have rights to the server

Options

For explanations of features, click where appears.
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NDS Update Log
Purpose
You can specify the location where NDS* Manager will store the log file after performing an NDS version update 
operation.
This tab is accessed by selecting either Object > Preferences or Object > NDS Version > Update > Settings.
Note: If you access this tab through NDS Version > Update > Settings, changes made in the window affect this 
version update session only.

Options

For explanations of features, click where appears.
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NDS Update Options
Purpose
Use this option to set default preferences for how NDS* Manager handles the NDS version update operation.
This tab is accessed by selecting either    Object > Preferences or Object > NDS Version > Update > Settings.
Note: If you access this tab through NDS Version > Update > Settings, changes made in the window affect this 
version update session only.

Options

For explanations of features, click where appears.
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NDS Version Update
Purpose
You will want to update the version of NDS* on a server whenever you receive an updated DS.NLM from Novell*. 
Updated versions of the DS.NLM are periodically sent out over NetWire* (Novell's electronic forum).
Each update of NDS fixes problems and increases functionality. When a new version of NDS is released, the new 
features in NDS are not available unless all servers in a partition's replica ring are running the same version of NDS.
Important: Version update does not support updates across operating system releases. In other words, this feature 
will not update a NetWare* 4.1 server's version of NDS to a NetWare 4.11 version of NDS. This feature will update 
NetWare 4.1 servers running an older version of NDS (such as 489) to a newer version of NDS for NetWare 4.1 (such
as 496).
If a new version of the NetWare 4.11 NDS is released on NetWire, you can update your NetWare 4.11 servers with 
the new version.

Options

For explanations of features, click where appears.
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NDS Version Update Complete
Purpose
NDS* Manager has completed the NDS version update operation.

Options

For explanations of features, click where appears.
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Replica Information
Purpose
Use this dialog box to choose the replica to view information about.
An easier way to view replica information is to double-click a replica in the partition grid.

Options

For explanations of features, click where appears.



Partition Continuity
Purpose
From the Partition Continuity view, you can identify whether any of a partition's replicas are experiencing 
synchronization errors, and you can perform repair operations.
Partition Continuity displays the replica list (columns) of each server (rows) that holds a replica of the chosen 
partition.
Hint: To understand the partition grid, read it horizontally, one server at a time. Each row represents the replica list of 
that server.

Options

For explanations of features, click where appears.



Partition Information
Purpose
You can view partition information to check the overall condition of a partition. The Partition Information dialog box 
helps you identify the number of replicas of the chosen partition and provides synchronization information.

Options

For explanations of features, click where appears.



Alias Information
Purpose
The Alias Informatiion dialog box identifies the aliased container object.    In NDS* Manager, only container aliases 
are displayed.    Aliases are created so that users do not need to know the location of an object in the directory tree in 
order to access that object.    For instance, a system administrator can move a container object to a new location 
while still providing access through an outdated location.

Options

For explanations of features, click where appears.
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Rename
Purpose
Use this screen to rename a partition.

Options

For explanations of features, click where appears.



Partitions Synchronization Check
Purpose
This dialog box provides information about the general state of the partitions checked after a Check Synchronization 
operation.

Options

For explanations of features, click where    appears.



Preferences 
Purpose
Set preferences to create default settings for how NDS* Manager displays information, how it processes NDS version
update operations, and where it stores the log file after performing an NDS version update operation.

Options

For explanations of features, click where appears.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Print
Purpose
You can print information about a container, server, partition, or replica. Different options are available, depending on 
what type of object you have selected.

Options

For explanations of features, click where appears.



Print Partition Grid
Purpose
Print from the partition grid so you don't have to manually record a partition's replica list.

Options

For explanations of features, click where appears.



Receive Updates
Purpose
This operation forces the replica on the chosen server to receive all NDS* objects from the master replica of the 
partition. While in process, this operation marks the replica on the chosen server as a new replica.
The replica state can be seen in the replica list of the server from the Tree view or the list of Partitions and Servers. 
The replica's current data will be overwritten with the data from the master replica.
Although NDS automatically synchronizes the Directory data among replicas (so that each replica is sent the most 
recently updated Directory objects), this operation lets you manually synchronize the Directory objects of replicas if 
any non-master replicas get out of sync.
Perform this operation if a replica becomes corrupted or has not received updated data for an extended period of 
time.
From the Partition Continuity view, you can identify which replicas are out of sync with the data of the master 
replica. They will appear in the partition grid with an exclamation point (!) on the replica icon. For example, a 

read/write replica with a synchronization error will appear in the grid as .
If any replicas are out of sync, you should receive updates from the master replica.
You cannot choose this option from a master replica. The master replica is assumed to be the most current and 
accurate copy of the partition. If it's not, assign one of the other replicas to be the master using the Change Replica 
Type operation. The current master replica will be changed automatically to read/write.
Note: This operation may create a lot of network traffic, so it is best to run this operation during a period of light 
network traffic.

Options
Server
Identifies the server that holds the replica to be updated by the master.
Partition
Identifies the partition whose master will broadcast updates to the chosen replica.
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Remove Server
Warning: Misuse of this operation can cause irrevocable damage to the NDS* tree.
If a server that is no longer in the tree appears in the replica ring, instead of using the remove server operation, 
perform a Delete Server operation to delete the server's object.
Over a period of time, the server object will be deleted and the replica ring will be updated accordingly. (This period of
time ranges from minutes to several hours.)
If the NDS tree is sufficiently damaged to prevent a delete server operation from completing normally, or if a server 
exists in the replica list which no longer has a replica of the partition, you may then have to use this operation.
Remove a server from a replica list when other servers are trying to synchronize with a server that has no replicas of 
the partition.
For example, in the Partition Continuity view---or upon running DSTRACE on the server---you might find errors 
indicating that a server still has record of another server in its replica list; when, in fact, the second server no longer 
contains a replica of the partition in question.    Use the Remove Server operation to remove the second server from 
the first server’s replica list.
Note: NDS Manager will attempt a safer Delete Replica operation each time a Remove Server request is made.    If 
the Delete Replica cannot be done, NDS Manager will prompt the user to continue and on a positive response will go 
forward with the Remove Server operation.    If NDS Manager is able to do a Delete Replica operation, the in-process 
dialog will reflect this in the titlebar and no log file will be displayed afterward.    If the Remove Server operation is 
done, NDS Manager will display the log file upon completion of the operation.
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Remove Servers
One or more servers in the target servers to be updated field has a newer version of DS.NLM (NDS) than the 
source server selected. Choose OK to remove the servers with a more current DS from the target list.
Or
The servers in the target servers to be updated field have a different operating system than the source server 
selected (for example, the source server may be NetWare 4.10 and target may be 4.11, or vice versa.). Choose OK 
to remove any incompatible target servers from the target list.



Repair Local Database
You can repair your local database records when you find that your NDS* database is corrupted. This operation 
resolves inconsistencies in the local NDS database so that it can be opened and accessed.
After the repair is completed, a log of the repair operations is displayed. You can inspect the repair operations in the 
log to see if additional work is needed to complete the repair. 
If objects in a replica are damaged, delete the replica and add it back, or receive updates from the master replica to 
make sure it is synchronized with the other replicas in the partition.
If you choose this option, there will be a short period of time when users will have limited access to resources on the 
server where you are running this operation.
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Repair Network Addresses
You can perform this operation to ensure that the servers in your network are broadcasting correct addresses.
This operation checks the network address of the chosen server in the local NDS* database by searching for the 
server's name in the local SAP tables.
If the operation finds an address in SAP, it compares this address to the NetWare* Server object's IPX network 
address property and the address in each replica property of every partition root object. If the address found differs 
from these, the operation updates it.
If the operation cannot find a SAP name-to-address mapping, it makes no repairs.
If you are getting NDS errors related to communication between servers, you can repair network addresses as an 
initial troubleshooting operation. This operation will not lock the NDS database and is safe to perform under all 
circumstances.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Repair Replica
This operation repairs only the chosen replica. Repairing a replica consists of checking the replica ring information on
each server that contains a replica and validating the remote ID information.
If you have not performed the Repair Local Database operation within the last 30 minutes, you should do so before 
performing this operation.



Repair Volume Objects
Purpose
This operation checks the association of all the mounted volumes with the Volume objects in the NDS* database.
If the volume is not associated with a Volume object, this operation looks for a volume in the context of the NetWare* 
Server object. If the volume is found, then the Volume object is attached to the volume. If it is not found, then this 
operation attempts to create one.
To create a volume, you must log in with rights to create a Volume object in the server's context.

Options
Validate Trustee IDs
If you choose this option, NDS Manager will validate trustee assignments on the file system with User object IDs, and
resolve any that are invalid.
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Replica Information
Purpose
If you want to verify that a replica is in an On state and is synchronizing with the rest of the tree, you can view replica 
information to check the replica's overall health and status. If you    identify a synchronization error, you can then 
Check Partition Continuity of the replica's partition.

Options

For explanations of features, click where appears.



Choose Object
Purpose
To locate a container (a context) in the directory, you can browse the Directory tree.

Options

For explanations of features, click where appears.



Send Updates
Purpose
When you send updates from a replica, the NDS* objects in that replica are broadcast from the server the replica 
resides on to all the other replicas of the partition, including the master replica.
The other replicas of the partition will combine the new objects sent with the objects they already have. If the other 
replicas have data in addition to the data sent to them, they will retain that data.
Although NDS automatically synchronizes the Directory data among replicas (so that each replica is sent the most 
recently updated Directory objects), this operation lets you manually synchronize the Directory objects of replicas if 
any replicas get out of sync.

Options
Server identifies the server that will broadcast the Directory data from its replica of the partition.
Partition identifies the partition whose data will be sent to each of the replicas.
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Server Information
Purpose
You can view server information to check the overall health and status of a server in your tree.

Options

For explanations of features, click where appears.



Tree View
Purpose
The Tree view (the default view) is one of the three views you can work from in NDS* Manager (the other two are the 
list of Partitions and Servers and Partition Continuity).
The Tree view has a hierarchical view that displays only container objects and NetWare* Server objects in the current
context. To view containers and servers below your current context, you must browse the tree by expanding 
containers.
To view a list of all partitions and servers in and below your current context (without having to expand containers), 

select View > Partitions and Servers, or select  from the button bar.

To perform repair operations, you must choose a partition and then select Object > Partition Continuity or     from the
button bar.

Options

For explanations of features, click where appears.
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Update Synchronization Information
Purpose
This operation will force NDS* Manager to reread the partition status of the chosen partition. You can perform this 
operation at any time. It is like a refresh of partition status.
You would want to perform this operation if you are receiving NDS errors or if you have performed partition operations
recently. After updating the partition status, you can Check Partition Continuity of the chosen partition to identify any 
synchronization errors.

Options

For explanations of features, click where appears.
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Verify Remote Server IDs
In an NDS* tree, the ID for an object is unique on each server. The remote server ID list contains a list of IDs for this 
server's object as it is found on other servers' databases. If the remote ID is incorrect, this server may return an NDS 
error, indicating that it cannot authenticate to the remote server.
This operation will verify the remote server's name, the remote server's ID in this server's database, and the remote 
ID, which is this server's ID as it is found in the remote server's database. If any errors are detected, this operation 
will attempt to repair the server IDs.
This operation does not lock the NDS database, so you can run this operation as an initial troubleshooting option if 
you identify NDS errors in Partition Continuity.
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View NDS Version
Purpose
View the version of NDS* that is running on the servers in your Directory tree to see if they are running the most 
current versions of the DS.NLM for that operating system release.
In other words, if you notice that certain servers in your tree are running NDS version 463 (a NetWare* 4.1 version of 
DS.NLM), while others are running version 496 (an updated NetWare 4.1 version of DS.NLM), you should update the 
server running 463 using the server running 496 as the source.
You can identify which version of NDS is the most current for a particular operating system by accessing NetWire*, 
Novell's electronic forum.

Options

For explanations of features, click where appears.
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View Log
After you perform a repair operation, NDS Manager displays a log file that should help you identify whether the 
operation was successful.
For example, if you perform a repair operation, the log file will help you identify whether the operation was successful,
or whether you need to perform other operations in order to solve synchronization problems.
The repair log file (DSREPR.LOG) is set internally by NDS Manager. This file can be found in SYS:SYSTEM of the 
server you run a repair operation on. You can save it to another file when viewing it, but you cannot specify a different
log file to be written to. This file is always reset after each repair operation (you cannot append to the file).
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View Log File for Version Update
After you perform an NDS Version Update operation, NDS Manager displays this log file to help you identify any 
errors.
You can specify many options for how NDS Manager writes to the log file for NDS Version Update operations. The 
location of the update log file defaults to your WINDOWS** directory; however, you can specify a different location in 
Preferences (under the Object menu).
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NDS Manager Installation Instructions
NDS* Manager can be run as a standalone executable from SYS:PUBLIC or as a tool from the Tools menu in 
NetWare* Administrator.
To run NDS Manager as a standalone executable under Windows** 3.1, create an icon that points to 
NDSMGR16.EXE in SYS:PUBLIC. Under Windows 95**, create an icon or shortcut that points to NDSMGR32.EXE in
SYS:PUBLIC\WIN95.

Windows 3.1 Users
To set up NDS Manager so that it can be accessed from the Tools menu in NetWare Administrator, if you haven't 
used NetWare Administrator yet, you need to open and close NetWare Administrator and then edit the 
NWADMN3X.INI file in the WINDOWS directory. Add the following line to the [Snapin Object DLLs WIN3X] section:

NDSMGR = NMSNAP16.DLL
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.
If you are running NetWare Administrator with the /N command line parameter (which causes your preferences to be 
registered in your User object in the Directory), you need to open and close NetWare Administrator and then do the 
following:
1. Choose the User object of the user who will use NDS Manager.
2. Right-click and choose Details.
3. Choose the Netware Registry Editor button.
4. Under Key, choose SNAPIN OBJECT DLLS WIN3X.

Note: If there is nothing in the Netware Registry Editor, add SNAPIN OBJECT DLLS WIN3X by choosing the Add
button under Key.

5. Choose the Add button under Values.
6. In Value Name, enter NDSMGR.
7. In Value, enter NMSNAP16.DLL.
8. Select String as the type 
9. Choose Add 
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.

Windows 95 Users
To set up NDS Manager so that it can be accessed from the Tools menu in NetWare Administrator, do the following:
1. Launch the Windows 95 NetWare Administrator (using no command line parameters)
2. From the Options menu, choose Save Settings on Exit.
3. Close the NetWare Administrator.
4. Run REGEDIT.EXE (the Windows 95 registry editor).
5. Choose HKEY_CURRENT_USER\Software\NetWare\Parameters\NetWare Administrator.
6. With Snapin Object DLLs WIN95 highlighted, from the Edit menu, choose New, and then choose String Value.
7. Type NDSMGR and press <Enter>.
8. With NDSMGR highlighted, from the Edit menu, choose Modify.
9. Type NMSNAP32.DLL in Value data and choose OK.
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.
If you are running NetWare Administrator with the /N command line parameter (which causes your preferences to be 
registered in your User object in the Directory), do the following:
1. Open the NetWare Administrator for Windows 95.
2. Choose the User object who will use NDS Manager.
3. Right-click and choose Details.
4. Choose the Netware Registry Editor button.
5.  Under Key, choose SNAPIN OBJECT DLLS WIN95.

Note: If there is nothing in the Netware Registry Editor, add SNAPIN OBJECT DLLS WIN95 by choosing the Add
button under Key.



6. Under Values, choose Add.
7. In Value Name, enter NDSMGR.
8. In Value, enter NMSNAP32.DLL.
9. Choose String as the type 
10. Choose Add.
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.

Windows NT Users
To set up NDS Manager so that it can be accessed from the Tools menu in NetWare* Administrator, do the following:
1. Launch the Windows NT NetWare Administrator (using no command line parameters)
2. From the Options menu, choose Save Settings on Exit.
3. Close the NetWare Administrator.
4. Run REGEDT32.EXE (the Windows NT registry editor).
5. Choose HKEY_CURRENT_USER\Software\NetWare\Parameters\NetWare Administrator.
6. With Snapin Object DLLs WINNT highlighted, choose Add Value from the Edit menu.
7. Type NMSNAPNT.DLL in the Value Name field.
8. In the Data Type field, choose REG_MULTI_SZ from the pulldown menu.
9. Choose OK.
10. Type NMSNAPNT.DLL in the Data field and choose OK.
11. Exit the Registry Editor.
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.
If you are running NetWare Administrator with the /N command line parameter (which causes your preferences to be 
registered in your User object in the Directory), do the following:
1. Open the NetWare Administrator for Windows NT.
2. Choose the User object who will use NDS Manager.
3. Right-click and choose Details.
4. Choose the NetWare Registry Editor button.
5.  Under Key, choose SNAPIN OBJECT DLLS WINNT.

Note: If there is nothing in the NetWare Registry Editor, add SNAPIN OBJECT DLLS WINNT by choosing the 
Add button under Key.

6. Under Values, choose Add.
7. In Value Name, enter NDSMGR.
8. In Value, enter NMSNAPNT.DLL.
9. Choose String as the type.
10. Choose Add.
11. Choose OK.
12. Exit the Registry Editor.
The next time you launch NetWare Administrator, you should see NDS Manager as an option under the Tools menu.

Access Control
You can control acces to NDS Manager by restricting access to certain files:

For Windows 3.X: NDSMGR16.EXE and NMSNAP16.DLL
For Windows 95: NDSMGR32.EXE and NMSNAP32.DLL
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Merge a Partition (With its Parent)
Purpose
When you merge a partition, the partition and its replicas combine with the parent partition, leaving only the parent 
partition.
You can merge a partition from either the Tree view or the list of Partitions and Servers.

Merge a Partition
1. Choose the partition you want to merge with its parent partition.

2. Choose Merge partition .
3. Confirm your request.
For more information, see Overview of Merging a Partition.



Move a Partition (a Container)
Purpose
Moving a partition lets you move a subtree in your Directory tree. You can move a partition root object (which is a 
container object) only if it has no subordinate partitions.
You can move a partition from either the Tree view or the list of Partitions and Servers.

Move a Partition
1. Choose the partition you want to move.

2. Choose Move partition .
3. (Optional) To move the partition to a context besides the root of the current tree, either type a new context in To 

Context, or choose the browse icon  and choose the destination partition from the browser.
4. (Optional) Check Create an alias for this container object.

You should understand why to create an alias when moving a container object.
5. Choose Yes.
6. Confirm your request.
For more information, including why and when you would create an alias for a container when you move it, see 
Overview of Moving a Partition.
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Overview of Creating and Merging Partitions
Overview of Creating a Partition
When you create partitions, you make logical divisions of your NDS* tree. These divisions can be replicated and 
distributed among different NetWare 4* servers in your network.
When you create a new partition, you split the parent partition and end up with two partitions. The new partition 
becomes a child partition.

For example, if you choose an Organizational Unit and create it as a new partition, you split the Organizational Unit 
and all of its subordinate objects from its parent partition.
The Organizational Unit you choose becomes the root of a new partition. The replicas of the new partition will exist on
the same servers as the replicas of the parent, and objects in the new partition will belong to the new partition's root 
object.
A partition consists of at least one container object and its associated subordinate objects. The container at the top of 
the partition is called the "root" of the partition.
Creating a partition may take some time, since all of the replicas need to be synchronized with the new partition 
information.
When you create a new partition, NDS Manager informs you that the Create Partition command was issued to NDS. 
If you attempt another partition operation while the partition is being created, you will receive a message telling you 
that the partition is busy.
You can look at the replica list for the new partition and know that the operation is complete when all replicas in the 
list are in an On state. You must manually refresh the view periodically, or else the states will not appear to change.

Overview of Merging a Partition
When you merge a partition with its parent partition, the chosen partition and its replicas combine with the parent 
partition. You do not delete partitions--you only merge and create partitions to define how the Directory tree is split 
into logical divisions.

There are several reasons you might want to merge a partition with its parent:
The Directory information in the two partitions is closely related
You want to delete a subordinate partition but you don't want to delete the objects in it
You're going to delete the objects in the partition.
You want to get rid of all replicas of the partition (merging a partition with its parent is the only way to delete 

the partition's master replica)
After moving a container (which must be a partition root with no subordinate partitions), you don't want the 

container to be a partition anymore
You experience changes in your company organization, so you want to redesign your Directory tree by 

changing the partition structure
Consider keeping partitions separate if the partitions are large (contain hundreds of objects), because large partitions 
slow down network response time.
The root partition in the tree cannot be merged because it is the top partition and has no parent partition to merge 
with.
The partition is merged when the process is completed on the servers. The operation could take a while to complete.
Warning: Before merging a partition, check the partition synchronization of both partitions and fix any errors before 
proceeding. By fixing the errors, you can isolate problems in the Directory and avoid propagating the errors or 
creating new ones.
Make sure all servers that have replicas (including subordinate references) of the partition you want to merge are up 
before attempting to merge a partition. If a server is down, NDS won't be able to read the server's replicas and won't 
be able to complete the operation.
If you receive errors in the process of merging a partition, resolve the errors as they appear. Don't try to fix the error 
by continuing to perform operations--doing so will result in more errors.
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Overview of Moving a Partition and Aborting a Partition Operation
Overview of Moving a Partition
Moving a partition lets you move a subtree in your Directory tree. You can move a partition root object (which is a 
container object) only if it has no subordinate partitions.

Note: When you move a partition, you must follow NDS* containment rules. For example, you cannot move an 
Organizational Unit directly under the root of the current tree, because the root's containment rules allow Locality, 
Country, or Organization, not Organizational Unit.
When you move a partition, NDS changes all references to the partition root object. Although the object's common 
name remains unchanged, the complete name of the container (and of all its subordinates) changes.
When you move a partition, you probably should choose the option to create an Alias object in place of the container 
you're moving. Doing so allows users to continue to log in to the network and find objects in their original Directory 
location.
The Alias object that is created will have the same common name as the moved container and will reference the new 
complete name of the moved container.
Warning: If you move a partition and do not create an Alias object in place of the moved partition, users who are 
unaware of the partition's new location will not easily find that partition's objects in the Directory tree, since they will 
look for them in their original Directory location.
This might also cause client workstations to fail at login if the workstation NAME CONTEXT parameter is set to the 
original location of the container in the Directory tree.
Because the context of an object changes when you move it, users whose name context references the moved object
need to update their NAME CONTEXT parameter so that it references the object's new name.
(To automatically update users' NAME CONTEXT after moving a container object, use the NCUPDATE utility.
After moving the partition, if you don't want the partition to remain a partition, merge it with its parent partition.
Make sure your Directory tree is synchronizing correctly before you move a partition. If you have any errors in 
synchronization in either the partition you want to move or the destination partition, do not perform a move partition 
operation. First fix the synchronization errors.

Overview of Aborting a Partition Operation
You can abort a Create or Merge partition operation if the operation has not yet progressed past the stage at which 
the change is committed. 
Use this feature to back out of an operation, or if your NDS network returns NDS errors or fails to synchronize 
following a partition operation.
Note: If replicas in your Directory tree experience synchronization errors, an abort operation may not always solve 
the problem. However, you can use this feature as an initial troubleshooting option.
If a partition operation cannot be completed because a server is down (or otherwise unavailable), either make the 
server visible to the network so the operation can complete, or attempt to abort the operation. If NDS cannot 
synchronize because the database is corrupted, you should abort any partition operation in progress.
Many partition operations may take considerable time to fully synchronize across the network, depending on the 
number of replicas involved, the visibility of servers involved, and the existing wire traffic.
If you get an error that says a partition is busy, it doesn't mean that you should abort the operation. You can usually 
expect partition operations to complete within 24 hours. If a particular operation fails to complete within this time 
frame, you should then attempt to abort the operation in progress.
Hint: If you are attempting to abort a merge partition operation, choose the partition (the child partition) that is 
merging with its parent. If you are attempting to abort a create partition operation, choose the parent partition.
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Overview of NDS Manager
In NetWare* 4.11, Novell Directory Services* Manager (NDS* Manager) replaces the Partition Manager utility that 
existed under the Tools menu in the NetWare Administrator* utility in earlier versions of NetWare 4.
NDS Manager provides:

Partitioning and replication services for NDS on a NetWare server
The ability to repair the NDS database from a client workstation, which reduces the network administrator's 

dependence on using RCONSOLE
NDS version update capability so that NetWare 4* servers in a network can be updated to a newer version 

of DS NLM
The ability to print a list of partitions in the Directory tree, the partition replica list (the replica ring), and server

data
Diagnostic features which allow the administrator to get a sense of the general condition of the Directory tree
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Overview of Setting Preferences and Print Options
NDS* Manager allows you to set preferences for how you want information displayed. You can also print information 
from any of the NDS Manager views.
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Overview of Working with NDS Manager
Using NDS* Manager, you can manage partitions, replicas, servers, repair operations, DS.NLM version updates, 
printing, and preferences.

Working in Views
Most operations can be performed from either the hierarchical Tree view or the list of Partitions and Servers. They 
are represented on the button bar by the icons  and 

. The other view from which you work in NDS Manager is the Partition Continuity view, from which you can view 
the condition of your tree and perform repair operations. Before using NDS Manager, you should take a few minutes 
to access these views and become familiar with their features and options.

Performing Operations
You can access the options to perform operations from the button bar, menu bar, or by right-clicking. A right-click of 
the mouse on a server, replica, or partition will bring up a pop-up menu with most of the available operations for that 
object.
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Overview of Adding, Deleting, and Changing Replica Type
To navigate this topic without scrolling, click    See also.

Overview of Adding a Replica
Creating multiple NDS* partitions does not, by itself, increase fault tolerance or improve performance of the Directory.
However, strategically using multiple replicas does.
Novell* recommends at least three real replicas for each partition if the Directory tree has enough servers to support 
that number. "Real" replicas means master, read/write, or read-only replicas (subordinate reference replicas are 
created and managed by NDS, not the administrator).
NDS replication provides:

Fault tolerance
If a disk crashes or a server goes down, replicas on servers in other locations can still authenticate users to the 
network and provide information on objects in partitions stored on the disabled server.
With the same information distributed on several servers, you are not dependent on any single server to 
authenticate you to the network or to provide services (such as login).
A single server can store replicas of multiple partitions.
Note: Directory replication does not provide fault tolerance for the file system. Only information about Directory 
objects is replicated.
To provide fault tolerance for your files, you must mirror or duplex your hard disks and enable the Transaction 
Tracking System* (TTS*) feature. TTS is enabled by default when the server is installed.

Faster access across a WAN link
If users currently use a WAN link to access particular Directory information, you can decrease access time and 
WAN traffic by placing a replica containing the needed information on a server that users can access locally. 
However, in some cases, WAN traffic could increase due to the amount of synchronization required.

Faster access to Directory information
Distributing replicas among servers on the network allows quick and reliable access because information is 
usually retrieved from the nearest available server containing the specified information.

Bindery services
Add a replica of a partition to a server (and set bindery context appropriately) to allow users to access bindery 
services provided by NDS objects stored in that partition.
Users will be able to access NDS objects providing bindery services only if real objects exist on that server. 
Adding a replica of a partition to the server adds real objects to the server and lets users with User objects in that 
partition log in to the server with a bindery connection.
If a partition is not stored on a server, the Set Bindery Context command will fail for contexts in the partition.

You can add additional replicas of a partition, within these guidelines:
You can have only one master replica. Additional replicas must be read/write or read-only.
You can store only one replica per partition on a server. A single server can store replicas of multiple 

partitions.
Most replicas should be read/write. Read/write replicas can be written to. They can handle object viewing, object 
management, and user login, just as the master replica can. They send out information for synchronization when 
a change has been made.
Read-only replicas cannot be written to. They allow object searching and viewing, and they are updated when the 
replicas of the partition synchronize.

Overview of Deleting a Replica
Deleting a replica removes the replica of the partition from a server.
If you want to remove a server from the Directory tree, you could delete replicas from the server before removing it. 
Removing the replicas reduces the chance of having problems removing the server.
You can also reduce synchronization traffic on the network by removing replicas. Keep in mind that you probably 
don't want more than six replicas of any partition.
Note: You cannot delete a master replica or a subordinate reference..
If the replica you want to delete is a master, you have two options:



Go to a server with another replica of the partition and make it the new master replica.
This automatically changes the master replica to a read/write replica, which you can then delete.

Merge the partition with its parent partition.
This merges the replicas of the partition with those of its parent and removes them from the servers they reside 
on. Merging removes partition boundaries, but not the objects. The objects continue to exist on each server which 
held a replica of the "joined" partition.

When you delete replicas, keep the following guidelines in mind:
For fault tolerance, you should maintain at least three replicas of each partition on different servers.
Deleting a replica deletes a copy of part of the Directory database on the targeted server.

The database can still be accessed on other servers in the network, and the server that the replica was on still 
functions in NDS.
You cannot delete or manage subordinate reference replicas. They are created automatically on a server by NDS 
when the server contains a replica of a partition but not of that partition's child.

Overview of Changing Replica Type
You can change the type of a read/write or a read-only replica. However, you cannot use a change replica type 
operation to change the master replica to a different type. 
You cannot change the type of a master replica, but a read/write or read-only can be changed to a master---and the 
master will be changed automatically to a read/write replica.
Most replicas should be read/write. Read/write replicas can be written to by client operations. They send out 
information for synchronization when a change has been made. Read-only replicas cannot be written to by client 
operations. However, they are updated when the replicas synchronize.
You cannot change the replica type of a subordinate reference. To place a replica of a partition on a server which 
currently has a subordinate reference requires an Add replica operation. 
A subordinate reference replica is not a complete copy of a partition. The placement and management of subordinate 
reference replicas is handled by NDS. They are created automatically on a server by NDS when the server contains a
replica of a partition but not of that partition's child.
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Overview of Repairing the NDS Database
To navigate this topic without scrolling, click    See also.

Overview of Verifying Remote Server IDs
In an NDS* tree, the ID for an object is unique on each server. The remote server ID list contains a list of IDs for this 
server's object as it is found on other servers' databases. If the remote ID is incorrect, this server may return an NDS 
error, indicating that it cannot authenticate to the remote server.
This operation will verify the remote server's name, the remote server's ID in this server's database, and the remote 
ID, which is this server's ID as it is found in the remote server's database. If any errors are detected, this operation 
will attempt to repair the server IDs.
This operation does not lock the NDS database, so you can run this operation as an initial troubleshooting option if 
you identify NDS errors in Partition Continuity.

Overview of Repairing a Replica
Repairing a replica consists of checking the replica ring information on each server that contains a replica, and 
validating the remote ID information. This operation repairs only the chosen replica.
If you have not performed the Repair Local Database operation within the last 30 minutes, you should do so before 
performing this operation.

Overview of Repairing Network Addresses
You can repair network addresses to ensure that the servers in your network are broadcasting correct addresses.
This operation checks the network address for every server in the local database by searching for the server's name 
in the local SAP tables.
If this operation finds an address in SAP, it compares this address to the NetWare* Server object's IPX network 
address property and the address in each replica property of every partition root object.
If the address it finds differs from these, this operation updates it. If this operation cannot find a SAP name-to-address
mapping, then it cannot make a repair for that server.
If you are getting DS errors related to communication between servers, you can repair network addresses as a 
troubleshooting option since it will not lock the NDS database.

Overview of Repairing Local Database
You can repair your local database records when you find that your NDS database is corrupted. This operation 
resolves inconsistencies in the local Directory database so that it can be opened and accessed.
After the repair is completed, a log of the repair operations is displayed. Inspect the repair operations in the log to see
if additional work is needed to complete the repair. 
If objects in a replica are damaged, delete the replica and add it back, or receive updates from the master replica to 
make sure it is synchronized with the other replicas in the partition.
If you choose this option, there will be a short period of time when users will have limited access to resources on the 
server where you are running this operation.

Overview of Assigning a New Master Replica
Important: Don't use this feature to change a replica type. This is a repair feature that should only be used when the 
current master replica is corrupted or lost.
Assign a new master replica if the current master replica is corrupted or if the server the current master resides on 
loses data integrity or experiences hardware failure.
You need a master replica to perform operations with a partition. Assigning a new master replica allows you to 
convert an existing replica to the master replica, and allows you to perform partitioning operations.

Overview of Removing a Server from a Replica List

Warning: Misuse of this operation can cause irrevocable damage to the NDS* tree.
If a server that is no longer in the tree appears in the replica ring, instead of using the Remove Server operation, 
perform a Delete Server operation to delete the server's object.
Over a period of time, the server object will be deleted and the replica ring will be updated accordingly. (This period of
time ranges from minutes to several hours.)
If the NDS tree is sufficiently damaged to prevent a Delete Server operation from completing normally, or if a server 



exists in the replica list which no longer has a replica of the partition, you may then have to use this operation.
Remove a server from a replica list when other servers are trying to synchronize with a server that has no replicas of 
the partition.
For example, in the Partition Continuity view---or upon running DSTRACE on the server---you might find errors 
indicating that a server still has record of another server in its replica list; when, in fact, the second server no longer 
contains a replica of the partition in question.    Use the Remove Server operation to remove the second server from 
the first server’s replica list.
Note: NDS Manager will attempt a safer Delete Replica operation each time a Remove Server request is made. If the
Delete Replica cannot be done, NDS Manager will prompt the user to continue and on a positive response will go 
forward with the Remove Server operation. If NDS Manager is able to do a Delete Replica operation, the in-process 
dialog will reflect this in the titlebar and no log file will be displayed afterward. If the Remove Server operation is done,
NDS Manager will display the log file upon completion of the operation.

Overview of Repairing Volume Objects
This operation checks the association of all the mounted volumes with Volume objects in the Directory.
If the volume is not associated with a Volume object, this operation looks for one in the context of the NetWare Server
object. If the volume is found, then the Volume object is attached to the volume.
If the volume is not found, then this operation attempts to create one.
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Overview of Synchronizing the NDS Database
To navigate this topic without scrolling, click    See also.

Overview of Synchronizing a Partition Immediately
Although Novell Directory Services* (NDS*) automatically synchronizes the Directory data of replicas (so that each 
replica is sent the most recently updated data), you can manually synchronize the Directory data of replicas if any 
replicas get out of sync.
When you choose to synchronize immediately, every server that holds a replica of the partition you choose will 
attempt to synchronize its replica information with the replica information on the other servers.
You can perform this operation to synchronize changes you recently made to Directory data. For example, if you 
modified system or user login scripts, you can synchronize those changes so users can be authenticated to the 
network immediately.

Overview of Receiving Updates from the Master Replica
This operation forces the replica on the chosen server to receive all NDS objects from the master replica of the 
partition. While in process, this operation marks the replica on the chosen server as a new replica (the replica state 
can be seen in the replica list of the server from the Tree view or the list of Partitions and Servers).
The replica's current data will be overwritten with the data from the master replica.
Although Novell Directory Services automatically synchronizes the Directory data among replicas (so that each 
replica is sent the most recently updated Directory objects) this operation lets you manually synchronize the Directory
objects of replicas if any non-master replicas get out of sync.
Perform this operation if a replica becomes corrupted or has not received updated data for an extended period of 
time.
From the Partition Continuity view, you can identify which replicas are out of sync with the data of the master 
replica. They will appear in the partition grid with an exclamation point (!) on the replica icon. For example, a 
read/write replica with a synchronization error will appear in the grid as .
If any replicas are out of sync, you should receive updates from the master replica.
You cannot choose this option from a master replica. The master replica is assumed to be the most current and 
accurate copy of the partition. If it's not, assign one of the other replicas to be the master using the Change Replica 
Type operation. The current master replica will be changed automatically to read/write.
Note: This operation may create a lot of network traffic, so it is best to run this operation during a period of light 
network traffic.

Overview of Sending Updates from a Replica
When you send updates from a replica, the Directory objects in that replica are sent from the server the replica 
resides on to all the other replicas of the partition, including the master replica.
The other replicas of the partition will combine the new objects sent with the objects they already have. If the other 
replicas have data besides the data sent to them, they will retain that data.
Although Novell Directory Services (NDS) automatically synchronizes the Directory data among replicas (so that each
replica is sent the most recently updated Directory objects) this operation lets you manually synchronize the Directory
objects of replicas if any replicas get out of sync.

Overview of Viewing Synchronization Errors
In the Partition Continuity view, if the chosen partition has synchronization errors, those errors will appear as 
exclamation points on replica icons. For example, an error on a read/write replica would appear in the partition grid as

.
You can view the details about the synchronization error---possible causes and solutions---by double-clicking the 

replica icon and then choosing Help  from Current Sync Error.
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Overview of Viewing and Updating Version of NDS
Overview of Viewing the NDS Version on Servers in a Container
View the version of NDS* that is running on the servers in your Directory tree to see if they are running the most 
current versions of DS.NLM for that operating system release.
In other words, if you notice that certain servers in your tree are running NDS version 463 (a NetWare 4.1 version of 
DS.NLM), while others are running version 496 (an updated NetWare 4.1 version of DS.NLM), you should update the 
server running 463 using the server running 496 as the source.
You can identify which version of NDS is the most current for a particular version of NetWare by accessing NetWire* 
(Novell's electronic forum), or Novell's home page on the World Wide Web.

Overview of Updating Version of NDS on a Server
You should update the version of NDS on a server whenever you receive an updated DS.NLM. Updated versions of 
the DS.NLM are available, and periodically sent out, on NetWire (Novell's electronic forum).
Each update of NDS fixes problems and increases functionality. When a new version of NDS is released, the new 
features in NDS are not available unless all servers in a partition's replica ring are running the same version of NDS.
Important: Version update does not support updates across operating system releases. In other words, this feature 
will not update a NetWare 4.1 server's version of NDS to a NetWare 4.11 version of NDS. This feature will update 
NetWare 4.1 servers running an older version of NDS (such as 463) to a newer version of NDS for NetWare 4.1 (such
as 489).
If a new version of the NetWare 4.11 NDS is released on NetWire, you can update your NetWare 4.11 servers with 
the new version.
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Overview of Viewing Partition Data
To navigate this topic without scrolling, click    See also.

Overview of Checking the Synchronization Status of a Partition
Perform this operation as a low-level diagnostic check since it is safe to perform under all circumstances. NDS* 
Manager reads the partition status attribute for each partition to determine any synchronization errors.
This operation allows you to check the synchronization status of partitions in your tree. If you run this operation from 
the Tree view, you can check the status of the chosen partition only. If you run this operation from the list of 
Partitions and Servers, you can check the status of all the partitions in your Directory tree.
NDS Manager displays the findings of the synchronization check in a dialog box. You can then check the partition 
continuity of any partitions that have returned errors, and then run repair operations on those partitions.
This operation may provide incomplete information since it only checks for synchronization errors on the first server in
the replica list that responds to the request. (Synchronization errors may be occurring on other servers in the replica 
list.)
To check for synchronization errors among all servers that hold a replica of the chosen partition, go to the Partition 
Continuity view.

Overview of Checking Partition Continuity
To check partition continuity ("walk the replica ring" of a partition) is to examine all of the servers holding replicas of a 
selected partition and to verify that each server has the same information for the partition's replica list (or replica ring).
If each server holding a replica of the chosen partition does not have an identical replica list, or if a replica cannot 
synchronize with the Directory tree for any reason, then the Partition Continuity view display one or more errors.
Errors appear as exclamation points inside the replica icons and look like the following:

 
 

 

To get context-sensitive help on an error, double-click the icon and from the Replica Information dialog box. choose 
Help  next to Current Sync Error.
Note: You may also see icons representing unreadable replicas. Unable to read icons do not necessarily signify that 
the servers can't talk, but at the very least, there is some reason the client cannot contact the server for information.

Overview of Viewing the Partitions on a Server
You can choose a NetWare* Server object and view which partitions have replicas stored on it and the type of each 
partition's replica. Each partition is specified by the complete name of the container object at the root of the partition.
You can see how many partitions are stored on the server.
You might want to view the partitions stored on a server if you are planning to remove a NetWare Server object from 
the Directory tree. In this case, you could view the replicas you need to remove before removing the object.

Overview of Viewing a Partition's Replicas
You can choose a partition and view its replica list. This operation lets you identify:

Which servers the partition's replicas reside on
Which server holds the master replica of the partition
Which servers have read/write, read-only, and subordinate reference replicas of the partition

Overview of Viewing Information about a Partition
You can view the following details about a partition:

Its complete name
The server which holds the master replica.. This is a complete name.
The number of read/write, read-only, master, and subordinate reference replicas of the partition
The time of its last successful synchronization



The time of its last attempted synchronization
You can gather most of the information about a partition without leaving the main view you're working from. When you
choose a partition in the browser, the replica pane on the right of the browser displays replica information for the 
partition.
The most significant reason to view information about a partition is to identify its synchronization information. For 
example, if the time of a partition's last successful synchronization is earlier than the time of its last attempted 
synchronization, you know that the partition may have. synchronization errors. (This information about 
synchronization time is not available on NDS versions prior to 489).

Overview of Viewing Partition Hierarchy
You can view the hierarchy of partitions in your Directory tree from the Tree view. This view allows you to browse the 
logical structure of the partitions in your Directory tree by expanding and collapsing container objects. In other words, 
you can see which partitions are parent and which are child partitions.

Overview of Viewing a List of all Partitions in the Tree
You can view a flat list of partitions in your Directory tree from the list of Partitions and Servers.
If you want to simply list the partitions in your tree (from a certain context), use this view. If you need to see which 
partitions are parent and child partitions (the partition hierarchy), you must go to the Tree view.
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Overview of Viewing Replica Data
Overview of Viewing the Replica List of a Partition
From either the Tree view or the list of Partitions and Servers, you can choose a partition and view:

The replicas of that partition
The type of each replica
The state of each replica
The server each replica is stored on

However, from either of these two views, you will not get a complete list of each server's view. The replica list shown 
is the view of the first server to respond to the request. The Replica read field in the information bar tells which 
server was read.
Other servers holding a replica of the chosen partition may have different views of where the partition's replicas are 
stored.
To get a complete view of a partition's replica list, use the Partition Continuity view. This view displays all of the 
servers that hold a replica of the chosen partition, as well as each server's view of where replicas of the chosen 
partition are stored.

Overview of Viewing Replica Information
This is a safe operation that you can perform under all circumstances.
The most significant reason to view information about a replica is to view its synchronization information. (You can 
gather most of the information about a replica without leaving the main view you're working from.)
This operation allows you to view the following details about a replica:

Which partition the replica is a copy of
The server it is stored on
Its replica number
Its type
Its state
The last time it was successfully synchronized
Its referral address
Its current synchronization errors

You can also get additional help on the specific synchronization error by pushing the blue question mark button at 
the end of the error number line.



Overview of Viewing Server Information and Deleting a Server
View Information about a Server
You can gather most of the information about a server without leaving the main view you're working from. When you 
choose a server, its replica information is displayed in the replica pane on the right.
The most significant reason to view information about a server is to view its synchronization information.
You can view information about a server from the Tree view, the list of Partitions and Servers, or the Partition 
Continuity view.

View a List of Servers in the Directory
From the list of Partitions and Servers, you can view a list of the servers in and below your current context in the 
Directory tree. In other words, if you set your context to the root of your tree, you can view every server that exists in 
your tree without having to search the Directory tree by expanding containers in the Tree view.
This list takes longer to build than the Tree view.

Overview of Deleting a NetWare Server Object
Warning: Deleting a NetWare* Server object permanently removes the object from your Novell Directory Services* 
tree (the server still has SAP capabilities unless it is permanently down).
It also permanently removes the server's data and resources from the network.
Deleting a NetWare Server object may corrupt your NDS database, especially if the NetWare Server object provides 
NDS database services (such as storing replicas).
Use NDS Manager to remove the replicas on the NetWare server and avoid deleting a NetWare server that stores the
only replica of a partition of the Directory tree.
You want to delete a server when:

The server's hard drive goes bad and you want to reinstall the server.
You no longer need that resource in the tree due to company downsizing.

There are several ways to go about deleting a NetWare Server object:
One option (although we don't recommend this) is to bring a NetWare server down and delete its object.Then, 
reinstall NDS on the server using INSTALL.NLM at the server, or recreate the object after bringing the server back 
up.You will have to use NetWare Administrator to delete Volume objects associated with the deleted NetWare Server 
object.
Do not delete a server if you merely wish to move it to a new context. Use the NetWare Administrator to move the 
server object and its associated volume objects to another context.
If the server is functioning properly, do the following before deleting it:

Change the master replicas stored on this server to read/write replicas and then delete all replicas on the 
NetWare server.

Remove NDS from the server with the INSTALL.NLM. This procedure protects your NDS database from 
losing services. (This procedure will also delete the server for you.)
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Overview of Working with Partitions
NDS* Manager allows you to manage partitions in your Directory tree. You can manage the placement of partition 
boundaries in your Directory tree, and you can view partition data.
There are some general guidelines to follow when performing partition operations:

Make sure your Directory tree is synchronizing correctly before you move a partition.
You should check a partition's synchronization status before performing any operations. If you have 
synchronization errors, fix the synchronization errors before proceeding with the operation.

If possible, always perform partition operations with the latest version of DS.NLM.
After performing a partition operation, you need to wait for processes throughout the Directory to complete 

before you can perform an operation with that partition again.
Even though a partition operation may appear completed in NDS Manager, NDS requires time to synchronize any
changes to a partition with the replicas of the partition.
Many partition operations may take considerable time to fully synchronize across the network. While you can 
expect partition operations to complete within a few hours, the amount of time required for NDS to synchronize 
the changes in the Directory depends on:

The number of objects in the partition
The number of replicas that must be synchronized
The location of the replicas (they could be on a server across a WAN, for example)
The visibility of servers involved
Existing wire traffic
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Overview of Working with Preferences and Print Options
Like most programs with a graphical user interface, NDS* Manager allows you to set preferences for how information 
is displayed each time you run NDS Manager and how NDS Version Update behaves.
You can print hard copies of the information that appears in NDS Manager.
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Overview of Working with Repair Operations
Perform repair operations when you find synchronization errors or other problems in your NDS* database.
Most repair operations actually run DSREPAIR.NLM on the server. Any errors received during a repair operation are 
saved in a log file and displayed once the operation is complete.
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Overview of Working with Replicas
NDS* Manager allows you to manage partition replicas. You can manage both the number and type of replicas on a 
server. You can also view information about replicas so you can monitor their synchronization status or troubleshoot 
any errors.
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Overview of Working with Servers
You can

View information about a server
Delete a server
View and update the NDS* version on a server

Since replicas of partitions are stored on servers, any time you perform an operation that affects a partition or a 
replica, you are affecting the information that is stored on a server.
For a list of these operations, see Working with Repairs and Updates.
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Print Object Information
Purpose
You can print the information about a partition, replica, or server.
You can print object information from the Tree view or from the list of Partitions and Servers.

Print Object Information
1. From the Object menu, choose Print.

For information and instructions on choosing specific options, choose Help.



Print Replica List of a Partition
Purpose
You can print the replica list (the replica ring) of a partition. The replica list shows each server that has a replica of the
chosen partition, and each server's replica table.
You can print the replica list of a partition from the Partition Continuity view.

Print a Replica List of a Partition
1. From the File menu, choose Print.

For information and instructions on choosing specific options, choose Help.



Receive Updates from Master Replica
Purpose
This operation deletes the Directory data of a replica and replaces it with data from the master replica of the partition. 
Choose this option if the replica is corrupted or has not received updated data for an extended period of time.
You can receive updates from the master replica from the Tree view, the list of Partitions and Servers, or the 
Partition Continuity view.

Receive Updates from the Master Replica
1. Choose the server (the row) whose replica you want to receive updates.

Note: You cannot perform this operation on a master replica. A master replica cannot receive updates from itself.

2. Choose Receive Updates .
3. Confirm your request.
For more information, see Overview of Receiving Updates from Master Replica.



Remove a Server from a Replica List
Purpose

Warning: Misuse of this operation can cause irrevocable damage to the NDS* tree.
If a server that is no longer in the tree appears in the replica ring, instead of using the Remove Server operation, 
perform a Delete Server operation to delete the server's object.
Over a period of time, the server object will be deleted and the replica ring will be updated accordingly. (This period of
time ranges from minutes to several hours.)
If the NDS tree is sufficiently damaged to prevent a Delete Server operation from completing normally, or if a server 
exists in the replica list which no longer has a replica of the partition, you may then have to use this operation.
Remove a server from a replica list when other servers are trying to synchronize with a server that has no replicas of 
the partition.
For example, in the Partition Continuity view---or upon running DSTRACE on the server---you might find errors 
indicating that a server still has record of another server in its replica list; when, in fact, the second server no longer 
contains a replica of the partition in question.    Use the Remove Server operation to remove the second server from 
the first server’s replica list.
Note: NDS Manager will attempt a safer Delete Replica operation each time a Remove Server request is made. If the
Delete Replica cannot be done, NDS Manager will prompt the user to continue and on a positive response will go 
forward with the Remove Server operation. If NDS Manager is able to do a Delete Replica operation, the in-process 
dialog will reflect this in the titlebar and no log file will be displayed afterward. If the Remove Server operation is done,
NDS Manager will display the log file upon completion of the operation.

Remove a Server from a Replica List
1. From the Partition Continuity view, choose the server (the row) that has a replica in its list that you want to 

remove.
2. From the Repair menu, choose Remove Server.

Use the drop down box in the Replica field if you want to change the replica to be removed.
3. Confirm your request.

The View Log will appear when the operation is complete.
For more information, see Overview of Removing a Server from a Replica List.



Repair Volume Objects
Purpose
This operation checks the association of all the mounted volumes with Volume objects in the Directory.
If the volume is not associated with a Volume object, this operation looks for one in the context of the NetWare* 
Server object. If the volume is found, then the Volume object is attached to the volume.
If the volume is not found, then this operation attempts to create one.

Repair Volume Objects
1. From the Partition Continuity view, choose the server (the row) whose Volume objects you want to repair.

2. Choose Repair Volume Objects  
Check the Validate Trustee IDs option if you want NDS Manager to validate trustee assignments on the file 
system with User object IDs, and resolve any that are invalid. You might want to do this if you've deleted a lot of 
User objects that had trustee assignments on that volume. This would remove the trustee assigments on the 
objects that no longer exist in the tree.

3. Confirm your request.
The View Log will appear when the operation is complete.
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Repair a Replica
Purpose
Repairing a replica consists of checking the replica ring information on each server that contains a replica and 
validating the remote ID. This operation repairs only the chosen replica on the server you select.
If you have not performed the Repair Local Database operation within the last 30 minutes, do so before performing 
this operation. 

Repair a Replica
1. From the Partition Continuity view, choose the server (the row) whose replica you want to repair.

2. Choose Repair Replica .
3. Confirm your request.

The View Log will appear when the operation is complete.



Repair Local Database
Purpose
You can repair your local database records when you find that your NDS* database is corrupted. This operation 
resolves inconsistencies in the local Directory Database so that it can be opened and accessed.

Repair a Local Database
1. From the Partition Continuity view, choose the server (the row) whose local database you want to repair.

2. Choose Repair Local Database .
3. Confirm your request.

The View Log will appear when the operation is complete.
For more information, see Overview of Repairing Local Database.
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Repair Network Addresses
Purpose
You can repair network addresses to ensure that the servers in your network are broadcasting correct addresses.

Repair Network Addresses
1. From the Partition Continuity view, choose the server (the row) whose network addresses you want to repair.

2. Choose Repair Network Addresses .
3. Confirm your request.

The View Log will appear when the operation is complete.
For more information, see Overview of Repairing Network Addresses.
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Send Updates from a Replica
Purpose
When you send updates from a replica, the Directory data in that replica is broadcast from the server it resides on to 
all the other replicas of the partition, including the master replica. The other replicas combine the new information you
sent with the data they already have. If the replicas have data besides the data sent to them, they will retain that data.
Choose this option if replicas are corrupted or have not received updated data for an extended period of time.
You can receive updates from the master replica from the Tree view, the list of Partitions and Servers, or the 
Partition Continuity view.

Send Updates from a Replica
1. Choose the server (the row) whose replica you want to broadcast information.

2. Choose Send Updates .
3. Confirm your request.
For more information, see Overview of Sending Updates from a Replica.



Set Preferences
Purpose
Set preferences to create default settings for

How NDS* Manager displays information
How it processes NDS version update operations
Where it stores the log file after performing an NDS version update operation

You can set preferences from the Tree view or from the list of Partitions and Servers.

Set Preferences
1. From the Object menu, choose Preferences.

For information and instructions on choosing specific options, choose Help.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Synchronize a Partition Immediately
Purpose
When you choose to synchronize immediately, every server that holds a replica of the partition you choose attempts 
to synchronize its replica information with the replica information on the other servers.

Synchronize a Partition Immediately
1. From the Tree view or the list of Partitions and Servers, choose the partition you want synchronized.

2. Choose Partition Continuity .

3. Choose Synchronize Immediately .
4. Confirm your request.
For more information, see Overview of Synchronizing a Partition Immediately.
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Update Version of NDS on a Server
Purpose
Update the version of NDS* on servers in your Directory tree whenever you receive an updated DS.NLM. Updated 
versions of the DS.NLM are periodically sent out over NetWire* (Novell's electronic forum).
Each update of NDS fixes problems and increases functionality. When a new version of NDS is released, the new 
features in NDS are not available unless all servers in a partition's replica ring are running the same version of NDS.
Note: After performing a version update, you may notice that after the servers are updated correctly, your client 
workstation may not recognize they were updated for up to 15 minutes to a half an hour.
Important: Version update does not support updates across operating system releases. In other words, this feature 
will not update a NetWare* 4.1 server's version of NDS to a NetWare 4.11 version of NDS. This feature will update 
NetWare 4.1 servers running an older version of NDS (such as 463) to a newer version of NDS for NetWare 4.1 (such
as 489).
If a new version of the NetWare 4.11 NDS is released on NetWire, you can update your NetWare 4.11 servers with 
the new version.
You can update the version of NDS on a server from either the Tree view or the list of Partitions and Servers.

Update Version of NDS on a Server
1. Choose the NetWare Server object that you want to be the source for version update (the server that will send a 

copy of its DS.NLM to other servers).
2. From the Object menu, choose NDS Version, then choose Update.

A dialog box will inform you if any servers in and below the current context in your Directory tree cannot be 
updated. They will be grayed in the list.

3. From the list of servers on the left, choose the servers whose version of NDS you want updated and choose the 
right arrow to move them under Target servers to be updated.

4. Choose OK.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Verify Remote Server IDs
Purpose
This operation verifies

The remote server's name
The remote server's ID in a server's database
The remote ID, which is this server's ID as it is found in the remote server's database

If any errors are detected, this operation will attempt to repair the server IDs.

Verify Remote Server IDs
1. From the Partition Continuity view, choose the server (the row) you want to verify remote server IDs on.

2. Choose Verify Remote IDs .
3. Confirm your request.

The View Log will appear when the operation is complete.
For more information, see Overview of Verifying Remote Server IDs.



View a Partition's Replicas
Purpose
You can choose a partition and view its replica list. This operation lets you identify

Which servers the partition's replicas reside on
Which server hosts the master replica of the partition
Which servers have read/write, read-only, and subordinate reference replicas of the partition
The state of each of the partition's replicas

You can view a partition's replicas from either the Tree view  or the list of Partitions and Servers 
.

View a Partition's Replicas
1. Choose a partition.

The servers which contain replicas of the chosen partition are shown in the replica pane on the right of the 
browser.



View Information about a Partition
Purpose
This is a safe operation that you can perform under all circumstances.
The most significant reason to view information about a partition is to view its synchronization information. (You can 
gather most of the information about a partition without leaving the main view you're working from.)
You can view information about a partition from the Tree view, the list of Partitions and Servers, or the Partition 
Continuity view.

View Information about a Partition from the Tree view or the List of Partitions and Servers
1.  Choose the partition you want information about.
2. Right-click and choose Information.

View Information about a Partition from Partition Continuity
1. From the Repair menu, choose Information, then choose Partition.



View Information about a Replica
Purpose
This is a safe operation that you can perform under all circumstances.
The most significant reason to view information about a replica is to view its synchronization information. (You can 
gather most of the information about a replica without leaving the main view you're working from.)

View Information about a Replica
1. From either the Tree view or the list of Partitions and Servers, choose a partition or a NetWare* Server object.
2. Right-click on a replica and choose Information.
To view replica information from the Partition Continuity view, right-click a replica in the grid and choose Information.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



View Information about a Server
Purpose
You can gather most of the information about a server without leaving the main view you're working from. When you 
choose a server, its replica information is displayed in the replica pane to the right. 
The most significant reason to view information about a server is to view its synchronization information.
You can view information about a server from the Tree view, the list of Partitions and Servers, or the Partition 
Continuity view 

View Information about a Server from the Tree view or the List of Partitions and Servers
1. Choose the NetWare* Server object you want information about.

Note: The list of Partitions and Servers is the easiest place to access server information. If you go to the Tree 
view, you will have to browse the tree by expanding partition root objects until you find the NetWare Server object
you want information about.

2. Choose Information .

View Information about a Server from the Partition Continuity View
1. Right-click a server name (in the far left column) and choose Information.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



View Information about an Alias
Purpose
You can view the origin of an alias.

View information about an Alias
1. Double-click an alias object to view the aliased object.



View List of Partitions in the Tree
Purpose
This operation allows you to view a list of all the partitions in your Directory tree in and below your current context.
If your Directory tree is large (hundreds of partitions) and you perform this operation from the root of your tree, you 
might have to wait several minutes while the list builds.
To avoid waiting long periods of time, perform this operation from a given context.

View a List of All Partitions in the Directory Tree

1. Choose Tree view .
2. Navigate to and highlight the root of the current tree.
3. Choose Partitions and Servers .
4. The list of partitions in the current context is built under the Partitions heading (in alphabetical order).

View the Partitions in a Given Context

1. Choose Tree view .
2. Navigate and highlight the container that you want to set as the new context.
3. Right-click and choose Set Context.
4. Choose Partitions and Servers  



View a List of Servers in the Directory
Purpose
This operation allows you to view a list of the servers in your Directory tree in and below your current context.
If your Directory tree is large (hundreds of partitions and servers) and you perform this operation from the root of your
tree, you might have to wait several minutes while NDS Manager builds a list of all the servers in your Directory tree.
To avoid waiting long periods of time, perform this operation from a given context. To do so, follow the second 
procedure below.
This list takes longer to build than the hierarchical Tree view, so in large trees, you need to be patient.

View a List of All Servers in Your Directory Tree

1. Choose Tree view .
2. Navigate to and highlight the root of the current tree.
3. Choose Partitions and Servers .

The list of servers in the current context is built under the Servers heading in alphabetical order.

View the Servers in a Given Context

1. Choose Tree view .
2. Navigate and highlight the container that you want to set as the new context.
3. Right click and choose Set Context.
4. Choose Partitions and Servers  

The list of servers in the current context is built under the Servers heading in alphabetical order.



View Partition Hierarchy
Purpose
You can easily view the partition hierarchy in your Directory tree from the Tree view. In the browser on the left side of 
the Tree view, you can expand container objects to view which partitions are parent and which are child partitions.

View the Partition Hierarchy in Your Directory Tree
1. Expand a partition root object by double-clicking the object.

Note: The partition icon  signifies a partition root object.
You can collapse the subtree by double-clicking the object again.



View Replica List of a Partition
Purpose
You can view the replica list of a partition from any view in NDS* Manager.

View the Replica List of a Partition
1. From either the Tree view or the list of Partitions and Servers, choose a partition.

The servers which contain replicas of the chosen partition are shown in the replica pane to the right of the 
browser.

To examine all of the servers holding replicas of a chosen partition and to verify that each server has a similar view of 
the partition's replica list (or replica ring), you must Check Partition Continuity ("walk the replica ring" of a partition).

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



View Synchronization Errors
Purpose
When working in the Partition Continuity view, you may see an error on one of the replicas in the grid. An error 
appears as an exclamation point (!) on a replica icon.

For example, an error on a read-only replica would appear in the partition grid as .
You can view context-sensitive help about the error on the replica. The help provides possible causes and solutions 
to the error.

View Synchronization Errors
1. Double-click the replica with the error.

2. From the Replica Information dialog, click Help  next to Current Sync Error.



View the Partitions on a Server
You can view which partitions are allocated to a server by selecting a NetWare* Server object and viewing its replica 
list. This is a routine operation that is safe under all circumstances.

You can view the partitions on a server from either the Tree view  or the list of Partitions and Servers 
.

View the Partitions on a Server
1. Choose a NetWare Server object.

If you are in the Tree view, you might have to browse down the Directory tree until you find the NetWare Server 
object whose partitions you want to view.
Once you have highlighted the NetWare Server object, the partitions stored on the chosen server, as well as the 
partition's replica type, are shown in the replica pane on the right of the browser.

For more information, see Overview of Viewing the Partitions on a Server.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



View Version of NDS on Servers in a Container
Purpose
View the version of NDS* (DS.NLM) on all the servers in a container object to determine whether to update the 
DS.NLM on any servers. If the version of NDS on a server is not the most current version in the tree, consider 
updating the server's DS.NLM with the version from another server.
You can view the version of NDS on servers in a container from either the Tree view or the list of Partitions and 
Servers.

View Version of NDS on Servers in a Container
1. Choose the container you want to start from.

Note: If you are performing this operation from the list of Partitions and Servers, you cannot see the 
relationships among the partitions in your tree. It might be easier to perform this operation from the Tree view.

2. From the Object menu, choose NDS Version, then choose View.
Any servers prior to NetWare 4* will show up as Unknown (because they are bindery servers that do not have 
NDS).
For more information, see Overview of Viewing NDS Version on Servers in a Container.

Note: To view the version of NDS on a chosen server, you can simply highlight the server and choose the 
Information button  from the button bar.

* Novell trademark.    ** Third-party trademark.    For more information, see Trademarks.



Working with Preferences and Print Options
Overview

Overview of Working with Preferences and Print Options

Setting Preferences and Print Options
Overview
Set Preferences
Print Object Information
Print Replica List of a Partition



Working with Partitions
Overview

Overview of Working with Partitions

Creating and Merging
Overview
Create a Partition
Merge a Partition (With its Parent)

Moving and Aborting
Overview
Move a Partition (a Container)
Abort a Partition Operation

Viewing Partition Data
Overview
Check Synchronization Status of a Partition
Check Partition Continuity ("Walk the Replica Ring")
View the Partitions on a Server
View a Partition's Replicas
View Information about a Partition
View Information about an Alias
View Partition Hierarchy
View List of Partitions in the Tree



Working with Repair Operations

Overview
Overview of Working with Repair Operations

Synchronizing the NDS Database
Overview
Synchronize a Partition Immediately
Receive Updates from Master Replica
Send Updates from a Replica
View Synchronization Errors

Repairing the NDS Database
Overview
Verify Remote Server IDs
Repair a Replica
Repair Network Addresses
Repair Local Database
Assign a New Master Replica
Remove a Server from a Replica List
Repair Volume Objects



Working with Replicas
Overview

Overview of Working with Replicas

Adding, Deleting and Changing Type
Overview
Add a Replica
Delete a Replica
Change Replica Type

Viewing Replica Data
Overview
View Replica List of a Partition
View Information about a Replica



Working with Servers
Overview

Overview of Working with Servers

Viewing and Deleting
Overview
View Information about a Server
View List of Servers in the Directory
Delete a NetWare Server Object

Viewing and Updating Version of NDS
Overview
View Version of NDS on Servers in a Container
Update Version of NDS on a Server



This replica is changing its replica type. To abort the operation in progress, from the Object menu, choose Partition, 
then choose Abort Operation.



This replica is in the final stages of changing its type. There are no processes to abort.



This replica is being deleted. There are no processes to abort.



This replica is getting ready to merge. To abort this process, choose Abort Partition Operation.



This replica is waiting for the parent partition's replica to finish its merge processes. To abort the operation in 
progress, from the Object menu, choose Partition, then choose Abort Operation.



This replica is in the final stages of merging. There are no processes to abort.



This replica is locked because its preparing to move a partition. There are no processes to abort.



This replica is getting ready to move a container. To abort this process, choose Abort Partition Operation.



This replica is waiting for its parent partition's replica to finish its move processes. To abort the operation in progress, 
from the Object menu, choose Partition, then choose Abort Operation.



This replica is moving a container. There are no processes to abort.



This replica is being added to the chosen server. There are no processes to abort.



This replica has completed all background processes. There are no processes to abort.
Note: Because a replica is in an on state does not necessarily mean that it has no synchronization errors; it simply 
means that the replica is not busy performing an operation.



This replica is near the final process of creating a new partition. To abort the operation in progress, from the Object 
menu, choose Partition, then choose Abort Operation.



This replica is getting ready to move an object. To abort the operation in progress, from the Object menu, choose 
Partition, then choose Abort Operation.



This replica is about to change its state to on. There are no processes to abort.



This replica is creating a new partition. To abort the operation in progress, from the Object menu, choose Partition, 
then choose Abort Operation.



This replica is in the final process of creating a new partition. There are no processes to abort.



This field displays the name of the container object at the top of the hierarchical browser. The default context is the 
context you were in when you launched NDS Manager.
This is a read-only field. If you want to change the context and view a different branch of your Directory tree, choose 
a container in the browser, right-click, and choose Set Context.



This field displays the name of the partition you have chosen in the hierarchical browser. You can change this field by 
selecting a different partition from the browser.
The replicas of this partition, the replica types, and their states, are displayed below.



Displays the name of the server from which replica information is being read and displayed.
When you choose a partition in the browser, NDS goes out on the wire and finds the closest server on the wire that 
contains a replica of that partition. Then NDS Manager displays the replicas of the chosen partition, their type, and 
their state as seen by that particular server.
Note: To verify that all servers that contain a replica of the chosen partition are synchronizing correctly, you can 
launch Partition Continuity and view each server's view of the replicas.



Displays the state of each replica. 
For more information, see Description of Replica States .



This region is a hierarchical browser that displays all containers and servers in your current context. You can expand 
and collapse container objects to view the hierarchy of containers in your Directory tree.



Choose this browse button to search your Directory tree for the NetWare Server object you want to store the new 
replica on.



Displays the complete name of the partition you chose to be replicated.



Displays the type of replica and its associated icon.
For more information about replicas, see Description of Replica Types.



Displays the complete name of the NetWare Server object on which you want the replica stored.
Note: To choose a server to store the replica you're adding, choose the browse button.



This identifies the name of the selected alias object.



This identifies the original object to which the selected alias object points.



The replica whose type you're changing is a replica of this partition.



Displays the replica type and its associated icon.
The replica type of the replica you have chosen to change is chosen, but is not a valid choice. You must choose one 
of the other two options.
For more information, see Descriptions of Replica Types.



Displays the complete name of the server that holds the replica whose type you're changing.



If the chosen replica has synchronization problems, an error code is displayed.

Note: To access information about the synchronization error, choose the help button .



Choose this button to access information about synchronization errors.



Displays the time that the chosen replica was last synchronized with other replicas of the partition.



Displays the complete name of the partition represented by the chosen replica.



Displays the internal number that this replica is known by in the NDS database.



Displays the replica number that uniquely identifies the chosen replica in the NDS database.



Displays the replica's current state of activity.
For more information, see Descriptions of Replica States.



Displays the replica type.
For more information, see Descriptions of Replica Types.



Displays the server that was read.    This can be any one of the replicas.



Displays the complete name of the NetWare server that stores the chosen replica.



Displays the full name attribute of the NetWare Server object. This field will be empty unless you assign a full name.



Displays the version of NDS on the selected server. 
Novell strongly recommends that you maintain the most recently released version of NDS on all servers in your 
Directory tree.



Displays the network address this server is known by in the tables of other NetWare servers in the Directory tree.



Displays the total number of replicas that reside on the selected server.



Displays the complete name of the NetWare Server object.



Displays the version of the NetWare operating system running on the chosen NetWare server.



Displays the time the chosen server last synchronized its replica information with other servers in the Directory tree.



Choose this option to update the partition synchronization status on all servers that hold replicas of the chosen 
partition.



Displays the server you currently have selected.



Choose this option to update the partition synchronization status of the chosen partition on only the server specified 
in the text box below.



The button bar in NDS Manager allows you to perform partition and replica operations by simply clicking on a button.
Depending on whether you choose a partition, replica, or server, certain buttons will be enabled. For example, if you 
have a partition selected from the heirarchical browser on the left, the Create Partition button  is grayed (disabled) 
because the container is already a partition.



Displays your current context in the Directory tree.



Displays all the partitions stored on the server you have selected.



Displays the partition that is currently selected in the list of partitions.



Displays all the partitions in and below your current context in the Directory tree.
Note how in the window, the root of the current tree is the current context, so all partitions in and below the root are 
listed.



This field displays the name of the server from which replica information is being read and displayed.
When you choose a partition in the browser, NDS goes out on the wire and finds the closest server that contains a 
replica of that partition. Then NDS Manager displays the replicas of the chosen partition, their type,and their state---
as seen by that particular server.
Note: To verify that all servers that contain a replica of the chosen partition are synchronizing correctly, you can 
launch Partition Continuity and view each server's view of the replicas.



Displays the complete name of each server that holds a replica of the partition you have selected in the Partitions 
list.



Displays all the servers in and below your current context in the Directory tree.
Note how in the window, the root of the current tree is the current context, so all servers in and below the root are 
listed.



Displays the name of your Directory tree.



Displays the replica type.

Represents a master replica.

Represents a read/write replica.

Represents a read-only replica.

Represents a subordinate reference replica.
For more information, see Descriptions of Replica Types.



Choose the browse button to search for a different file that you want to specify as the new log file for version update 
operations.



Choose this operation to cancel the NDS version update operation in progress.



Choose this option to specify a new location for the version update log. If the file is not in the directory, NDS Version 
Update will create it.
The name of the current log file as specified in your Preferences is displayed in the text box.



Choose this option to complete the version update operation in progress. NDS version update will continue, but will 
not record an errors it encounters in a log file.



Displays the complete name of the partition to be moved.
Note: To change the partition to be moved, you must choose No and choose a different partition.



Check this box to allow users to continue to log in to the network and find objects in their original Directory location.
The Alias object that is created will have the same object name as the current container and will reference the object 
for the new container.
Warning: If you move a partition and do not create an Alias object in place of the moved partition, users who are 
unaware of the partition's new location will not easily find objects in the Directory tree, since they will look for them in 
their original Directory location.
This might also cause client workstations to fail at login if the NAME CONTEXT parameter is set to the original 
location of the container in the Directory tree.
Because the context of an object changes when you move it, users whose name context references the moved object
need to update their workstation NAME CONTEXT parameter so that it references the object's new name.
(To automatically update workstation NAME CONTEXT parameters after moving a container object, use the 
NCUPDATE utility. For instructions, see "NCUPDATE" in Utilities Reference.)



Displays the complete name of the container you're moving the partition to.
Note: To choose a container to move the partition to, choose the browse button.



Displays the name of the server that NDS Manager can't access. 



Displays an error message that helps you identify the cause of the error.



Displays the number of servers that NDS Manager could not communicate with to update its version of NDS.
To identify which servers were not updated, and why they were not updated, view the log file.



Displays the number of servers that were not updated with a new version of NDS.
To identify which servers were not updated, and why they were not updated, view the log file.



Displays the number of servers that were updated to a newer version of NDS.



Displays the number of servers you had selected to be updated.



Choose this button to view the log file NDS Manager created.
The log file may help you identify why errors occurred.



Displays the last date and time that NDS attempted to synchronize this partition's replicas.
NDS synchronizes automatically on a periodic basis, so the time displayed should not necessarily be your current 
time. The default for synchronization on a Directory tree (with no activity) is every 30 minutes, but that is a setable 
parameter on the server. If you have not changed the default, you can expect that the last attempted synchronization 
time will be within the last 30 minutes.
Note: If you make changes to the Directory, NDS attempts immediately to synchronize the changes among all 
replicas.



Displays the date and time of the last successful synchronization of this partition's replicas.
Note: If the date and time displayed do not match the date and time displayed in the Last attempted sync region, 
then you have synchronization errors and should check the continuity of the partition. To do so, choose Partition 
Continuity .



Displays the complete name of the server where this partition's master replica resides.



Displays the complete name of the partition you chose.



Displays the number of read/write, read-only, and master replicas of this partition. This information helps you identify 
the total number of replicas of this partition.



Displays the server that was read. This can be any one of the replicas.



Displays the number of subordinate references of the partition you chose.



Displays the name of the partition you had highlighted when you initiated the partition move.



Type here to rename the partition being moved.



When you choose No, the move operation is canceled and you are returned to the NDS Manager main screen.    The 
partition will not be renamed.



When you choose Yes, the partition will be renamed and then moved.



Displays general synchronization information about partitions in your Directory tree.
If all partitions that were checked are synchronizing (no errors), then the number of Partitions checked will 

match the number of All processed = Yes.
The number of All processed = No is the number of partitions with synchronization errors.
The number of Unable to Read is the number of partitions not read for various reasons, such as server 

downtime.



Opens the Partition Continuity screen and displays the replica list of the partition you have chosen.



Displays the Partition Information dialog box for the partition you have chosen.



Displays the complete name of each partition checked.    An icon to the left represents the synchronization status of 
each partition.

If All processed = Yes for a partition, then the partition icon  is shown to its left, signaling no apparent 
synchronization problems.

If All processed = No for a partition, then  is shown to its left, which signals a synchronization error for that 
partition.

If Unable to read a partition, then  is shown to its left, which signals that a partition cannot be read at this time.
Note: If All processed = No for a partition, highlight the partition and choose Continuity to view the partition's 
synchronization information.



The button bar lets you perform repair operations without having to use the menus.
When you drag your cursor over any of these buttons, a pop-up will identify what operation the button will launch.



Displays the complete name of the partition that has replicas with synchronization errors.
You are currently viewing this partition's replica list in Partition Continuity.



If the chosen server is experiencing synchronization errors with more than one other replica, you can choose the 
drop-down list to select the replica for which you want to view the synchronization error.



Displays the complete name of the server that holds the replica with synchronization errors.



Displays the name of the partition you chose. The replicas displayed in the partition grid are replicas of this partition.



Choose this drop-down list list box to select a different replica.



Displays the complete name of the partition you have selected.



Displays the name of the replica to view information about. To view information about a different replica (column), 
choose the drop-down box to the right of this field and choose the new replica.



Displays the complete name of the server (row) you have selected.



This is the partition grid, which displays each server's view of where replicas of the chosen partition reside.
If any replicas have synchronization errors, you will see one or more of the following error icons.

A synchronization error on a master replica
 A synchronization error on a read/write replica
 A synchronization error on a read-only replica
 A synchronization error on a subordinate reference replica

You could also receive an "Unable to Read" error for all the entries for a server, which could be caused by one or 
more of the following:

Login is disabled on that server
The server resides across a WAN link you don't have access to
NDS is locked on that server
The server is down
You are using VLMs and have attempted to exceed the maximum number of connections allowed



Displays the name of the servers that hold replicas of the chosen partition.



Displays the current default view upon launching NDS Manager.
The Tree view is the default view upon installation of NDS Manager. You can choose List and have the list of 
Partitions and Servers come up when you launch NDS Manager in the future.
The benefit to choosing Tree is that NDS Manager can easily display the partitions in your current context in the 
Directory tree. If you choose List, NDS Manager will build a list of all the partitions in and under your current context. 
If your Directory is large (hundreds of partitions), you may have to wait several minutes while this list builds.



This option lets you set preferences for how information is displayed upon launching NDS Manager. 



This option allows you to create default settings for where NDS Manager stores the log file after performing an NDS 
version update operation and how it appends data to the log file.



If you choose this option, each time you run NDS version update, instead of writing over the old log file, NDS 
Manager will open the log file and add to it.
Note: The log file displayed after a repair operation is a read-only viewer with limited display space. You cannot edit 
or attach comments to the log file in this viewer. To edit the log file, use a text editor.



This button opens a browser so you can choose a new update log file. If you have moved the log file, you can browse
and choose the file in its new location.



Displays the name and location of the current update log file as specified in your Preferences.
To change the name or location of this file, choose the browse button to the right, or modify your Preferences 
settings.



Choose Picture to have replica icons without text.
Choose With text to have the replica type identified underneath the icon.



This option lets you set preferences for NDS update options.



Displays the name and location of the current update log file as specified in your Preferences.
To change the name or location of this file, choose the browse button to the right, or modify your Preferences 
settings.



If you choose this option, NDS Manager will not notify you when you receive non-critical errors.
If you experience a critical error during the NDS version update process, the operation will be aborted by the system.
For example, if version update could not copy a file and could not restore the server back to its previous state, the 
update operation will indicate that the server is in a bad state.
In this case, you may need to manually go to that server and restore the backup copies of DS.NLM and 
DSREPAIR.NLM. To do so, simply rename the DSREPAIR.BAK to DSREPAIR.NLM and DS.BAK to DS.NLM.



Displays the current setting for how NDS version update locates servers.
By default, version update will locate only the servers in your current context and will display them in the Servers 
candidate list.
If you choose Entire Subtree, NDS version update will locate all servers in and below your current context and will 
display them in the Servers candidate list.



If you choose this option, NDS Manager unloads DSREPAIR from the target server and copies a new version of NDS 
(which includes a new DSREPAIR) to the target server.
Choose this option if you want to run NDS version update in unattended mode. If you don't choose this option, you 
will be prompted to remove DSREPAIR from every target server (every server to be updated) that has DSREPAIR 
loaded.



Choose this option to print information about the object you have selected.



Choose this option to print
The replica list of each server in the grid
The type of each replica
The replica number
The current state of each replica
The date and time of the last successful synchronization of each replica



Choose this option to print
The replica list of each server in the grid
The type of each replica in each server's replica list
The synchronization error code (if one exists) for each replica in the grid



Displays the name of your system printer.



Displays the type of object you have selected in either the Tree view or the list of Partitions and Servers.



Choose this option to print only the Directory tree as it appears in your browser.



Choose this option if you want to print information in two columns on your paper. This is mainly a paper-saving 
feature.



Choose this option to print replica data about the partition or server you have selected.



Displays the current context in the Directory tree.



This is a delimiter field where you can limit the objects that appear in the list.
For example, to display only objects that begin with the letter Y, enter Y*.



Displays objects in the current context that you can choose.



This is a delimiter field where you can limit the objects that appear in the list.
For example, to display only objects that begin with the letter Y, enter Y*.



You can browse the Directory by double-clicking on containers to "walk down the tree." To "walk up the tree," choose 
the up arrow at the top of the field.



Choose this button to manually type a new context to search from.



Displays the hierarchical relationships of containers and servers in the Directory tree. In other words, you can see 
which partitions are parent and which are child partitions (the partition hierarchy).



Displays your current context in the Directory tree.



This field is the replica information pane.
If you have a partition chosen in the browser on the left, this field displays each server that holds a replica of the 
partition.
If you have a server chosen in the browser on the left, this field displays each partition that has a replica stored on the
server.
If you have chosen a container object that has not been partitioned chosen in the browser on the left, this field does 
not display anything.



Displays the name of the Directory tree.



Choose this browse button to choose a different context. 



Displays your current context in the Directory tree.



This option allows you to choose all of the servers that have NDS versions older than the source server.



Displays the complete name of all the servers in your current context.
NDS Manager will gray any servers that are incompatible targets for the source server.
Note: You can modify the settings for NDS version update so that NDS Manager searches the entire subtree and 
displays all servers in and below your current context. To do so, choose Settings.



Displays the complete name of the source server and the version of NDS on that server. This is the server that will 
send its NDS version to other servers.



Displays all the target servers (the servers that will be updated with the NDS version of the source server).



This is the version of NDS on the target server.



Displays the NDS version on the server.



Related Topics
Synchronize a Partition Immediately
Send Updates from a Replica
View Synchronization Errors



Related Topics
Verify Remote Server IDs
Repair a Replica
Repair Network Addresses
Repair Local Database
Assign a New Master Replica
Repair Volume Objects
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